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Directory Concepts & Terminology
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IBM

Basic Directory Example Y L

. Minnesota NER VS
= |IBM employee directory
= Entry data examples: | / \
» Name: IBM, Mark _
Rochester Somers Plailrtes

» Structure: organization, person

» Attributes: description, telephonew \ \ \

Manufacturing Engineering Executives Marketing
JELS Beth John Sam Lennie

507-555-1212
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Concept: Directory Hierarchy

= Entries are arranged in a hierarchical structure that reflects political,
geographic, or organizational boundaries.

» Entries that represent countries appear at the top of the hierarchy. Entries
representing states occupy the second level down in the hierarchy. The
entries below that can then represent people, organizational units, printers,
documents, or other items.

» Example: cn=beth,ou=marketing,o0=ibm,c=us

= You are not limited to the traditional hierarchy when structuring your
directory. The domain component structure, for example, is gaining
popularity. With this structure, entries are composed of the parts of
TCP/IP domain names.

» Example: dc=ibm,dc=com
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LDAP Terminology: LDAP

Lightweight Directory Access Protocol

A directory service protocol that runs over TCP/IP

LDAP client, protocol, and server

Protocol defines interfaces between a client and a server for
requesting/returning data

©:2003 IBM Corporation
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Terminology Picture

= Future LDAP terms will refer back to this example

&

sm..ﬁ..m..

telephoneMumber=555-555-1234
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LDAP Terminology: Entry

= The LDAP directory model is based on a hierarchy of entries.
» The hierarchy is also referred to as a DIT (Directory Information Tree).
» Entries are also referred to as objects.

= Each entry consists of one or more attributes such as a name and a
type.
= Examples:
» Each circle in the picture is an entry.

» US is an entry of type country. US is the name of the entry.
» Tim Jones is an entry of type person. Tim Jones is the name of the entry.
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LDAP Terminology: ObjectClass

= Each entry has a special attribute called objectClass.

= An objectClass controls which attributes are required and allowed in an
entry.

= The values of the objectClass attribute determine the schema rules the
entry must obey.

= Example:
» country, organization, and person are object classes
» Other examples are organizational person which is a subtype of person.

©:2003 IBM Corporation
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LDAP Terminology: Attributes

Each entry consists of one or more attributes.

= The type of data stored in attribute values can be:
» DirectoryString, Binary (ex. JPEG photo), Integer, Boolean

Each entry also has operational attributes (automatically maintained):
» CreatorsName

» CreateTimestamp

» modifiersName

» modify Timestamp

= Example:
» mail and telephoneNumber are attributes.

» Some other possible attributes include fax, title, sn (for surname), and
jpegPhoto.

©:2003 IBM Corporation
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LDAP Terminology: DNs

= LDAP refers to entries with Distinguished Names (DNs).

= Distinguished names consist of the name of the entry itself as well as
the names, in order from bottom to top, of the objects above it in the
directory.

= Each entry has at least one attribute that is used to name the entry. This
naming attribute is called the Relative Distinguished Name (RDN) of the
entry.

= The entry above a given RDN is called its parent Distinguished Name.

» Examples:
- the complete DN for the entry Tim Jones is cn=Tim Jones, 0=IBM, c=US
— the RDN of the entry is cn=Tim Jones
— the parent DN for cn=Tim Jones is 0=IBM, c=US
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LDAP Terminology: Suffix

= A suffix defines a "namespace" that the LDAP server recognizes.

= Suffixes are the highest level distinguished names in the server
configuration.

= The server can access all objects in the directory that are below the
specified suffix in the directory hierarchy.

= An LDAP server can serve many suffixes or namespaces.

= The suffix "o=ibm,c=us" tells the server that DNs that end in
"o=ibm,c=us" are in this server's namespace.

= DNs that do not fall within the defined suffixes are not handled by the

server.

» The server will return "no such object" or will redirect the client to another
server that might handle that namespace (referral).

= Example:

» The suffix o=ibm, c=us must be specified in the server configuration in order
for the server to respond to client queries regarding Tim Jones.

©:2003 IBM Corporation



IHIH1
il
]

IBM eServer iSeries

LDAP Terminology: Schema

= Each directory has a schema.

= A schema is a set of rules that determine the structure and contents of
the directory.

= Use IBM Directory Management Tool (DMT) to edit schema files.

= Default schema files are in /QIBM/ProdData/OS400/DirSrv. Copy to
UserData to update.

= Schema includes:
» objectclasses
» attributetypes
> ibmattributetypes
» matchingrules
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Example Schema

objectclasses=( 2.5.6.2 NAME 'country' DESC 'Defines entries that represent countries.' SUP
top MUST ¢ MAY ( description $ searchGuide ) )

objectclasses=( 2.5.6.4 NAME 'organization' DESC 'Defines entries that represent
organizations. An organization is generally assumed to be a large, relatively static grouping
within a larger corporation or enterprise.' SUP top MUST o MAY ( businessCategory $
description $ destinationIndicator $ facsimileTelephoneNumber $ internationallSDNNumber
$ I $ physicalDeliveryOfficeName $ postalAddress $ postalCode $ postOfficeBox $
preferredDeliveryMethod $ registeredAddress $ searchGuide $ seeAlso $ st $ street $
telephoneNumber $ teletexTerminalldentifier $ telexNumber $ userPassword $ x121Address

))

objectclasses=( 2.5.6.6 NAME 'person' DESC 'Defines entries that generically represent
people.' SUP top MUST ( cn $ sn ) MAY ( description $ jpegPhoto $ seeAlso $
telephoneNumber $ title $ userPassword ) )

objectclasses=( 2.5.6.7 NAME 'organizationalPerson' DESC 'Defines entries for people
employed by or associated with an organization.' SUP person MAY ( destinationindicator $
facsimileTelephoneNumber $ internationallSDNNumber $ | $ ou $
physicalDeliveryOfficeName $ postalAddress $ postalCode $ postOfficeBox $
preferredDeliveryMethod $ registeredAddress $ st $ street $ teletexTerminalldentifier $
telexNumber §$ title $ x121Address ) )

attributetypes=( 2.5.4.20 NAME 'telephoneNumber' DESC "Telephone number.' EQUALITY
2.5.13.20 SUBSTR 2.5.13.21 SYNTAX 1.3.6.1.4.1.1466.115.121.1.50 )
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Authentication
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LDAP Authentication

Each LDAP client must authenticate to the LDAP server.
= The process of authenticating is called a "bind" operation.

If no bind is performed, the client is treated as "anonymous".

= There are 4 ways to provide a client identity.

©:2003 IBM Corporation
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Authentication Choices

1. Provide user name and password
» Also called a "simple bind"

» Example: Administrator - has access to all objects and attributes. The DN
(cn=administrator is the default on iSeries) and password are part of the server
configuration.

» A. DN with password
— Client's identity is a DN (an entry in the directory) which contains a userpassword attribute.
Server verifies the password.
- dn: cn=John Smith, cn=users, o=acme, c=us
objectclass: inetorgperson
userpassword: secret

» B. DN with UID

— The entry has no userpassword attribute. The entry has a UID attribute which is the same as
an OS/400 user profile. Server calls OS/400 to see if password is valid for that user profile.
- dn: cn=John Smith, cn=users, o=acme, c=us
objectclass: inetorgperson
uid: JSMITH <== JSMITH must be a user profile on the same system

» C. Projected user and password
— DN is an OS/400 user profile. It does not map to a user entry in the directory.
— All OS/400 user profiles are always available using LDAP.

— The LDAP server verifies the user is an OS/400 user profile and the passwords match.
- 0s8400-profile=JSMITH, cn=accounts, 0s400-sys=SystemA.acme.com
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Authentication Choices (cont.)

2. Provide a Kerberos ticket
» Uses SASL (Simple Security and Authentication Layer) bind

» Used in Windows 2000 and other environments.

— LDAP server can be configured to generate a DN based on the Kerberos principal name:
ibm-kn=jsmith@acme.com

— Or server can be configured to search for an object that has an altSecurityldentities
attribute matching the Kerberos principal:
dn: cn=John Smith, cn=users, o=acme, c=us
objectclass: inetorgperson
objectclass: ibm-securityIdentities

altsecurityidentities: kerberos:jsmith@acme.com

— The above would result in a client with the identity cn=John Smith,cn=users,o=acme,c=us

3. Provide Digital Client Certificate
» Another form of SASL bind
» Uses SSL/TLS
» The client identity is the DN from the certificate used to establish the connection.
» This is optionally a DN of an object in the directory.
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Configuring the LDAP Server
- the first time
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iISeries Navigator: Directory

¥ iSeries Navigator
File Edit “iew Help

-‘,ﬁ .©@||@Q 3 minutes old

| Ervaronment; My Connections | Rchazum: TCPAR
=@ Rchaspsm = || server Mame | Status | Deseription |
-85 Basic Operations “Fa DLFM Stopped Datalinks File Server
@ W':'fl_* Mar'!agement ) =E'E\-"irtual Frivate Metworking Stopped Wirtual private networking
. B* Configuration and Service *H ASFTomeat Started A5FTomeat server
Eli] Network ! ) T Triggered Cache Manager Stopped Tringered cache manaager
% TCP/IF Configuration ﬁ: FTP Sharted FTP
ﬁ giemute Access Services ﬁﬁ LFD Started LFD
;.___ﬁ%”:; - “fa POP Stopped FOP
e ﬁg Remote Execution Stopped Remote execution
i iGemnies Access
=1 HISMTP Started SMTP
e A TELNET Started TELMET
User-Defined
E]"@ IF Palicies ‘ﬁﬁ HTTP &dministration Started . HTTP administration
BB windows Adrministration M e Mot configured Directary =
&0 Enterprise |dentity M apping LI q| - | v
- : Properties

i by Caonfiguration k.
B 2dd a connection [C] Confiqure subsystems for server jobs o Configure spztem az Directony server
(@ Install additional components Create a new DMS Wame Server b D Help for related tasks

E] Configure sustern as DHCP server

o

| [18- 29 of 29 objects
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Configure local or remote

Directory Services Configuration Wizard - Welcome

VWelcame ta the Directary Services Canfiguration Wizard. This wizard will help wou ta
configure your iSeries senver to use a lightweight directory access protocol (LDAF)
directory server. You can store many types of infarmation in an LDAP directary. In

additian, your system can use an LDARP directory to store information used by its
applications.

Which ofthese options do you want to select?

& Configure 3 local LODAP directory serveri

¢ Identify a remote LOAP directory server on your netwoark,

Click Cancel at any time to cancel the wizard.

Details |

’Ne;d x Cancel |
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Use the defaults

Directory Services Configuration Wizard - Specify Settings

You can specify canfiguration settings foryour LOAP directony server, aryod can have the
wizard assign default settings. Ifyou choose to have default settings assigned, you will
have a chance to review them before the server is configured.

Do you want the wizard to configure yaur LDAR directory semer with default settings?

ﬁElack ‘Nex‘[ | xoancel

©:2003 IBM Corporation
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Directory Services Configuration Wizard - Specify Adminiztrator DH

The directory server administrator has unrestricted access to all directory entries an the
SEerver.

YWihat do you want the distinguished name (O and passwaord to be far the administratar
ofthis directony’?

—Administratar Distinguished Mame

Select thiz option when you do not need to know the Administrator DR or
passwaord because anly the systermn will use the directary.

Administratar DM: |cn=administratur
Passward: |
Zonfirm password; |

©:2003 IBM Corporation
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Add a suffix

Directory Server Configuration Wizard - Specify Suffives

Directory suffixes determine which objects can be stored in the directory. Objects that
have one ofthese suffixes atthe end of their distinauished names (O~s) can be stored
in the directory. To get more information about suffixes, click Details.

YWhat suffives do you want an this serer?

Suffix

| Al

de=rchagyim,de=rchland de=ibm,de=com REmoye |

Details |

ﬁElack | *Next | XCanceI |
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Select the IP addresses

Directony Services Configuration Wizard - Select IP Addresses

Your systern has multiple IP addresses. [Tyou want to have another LDAP directory serer
on this system, you can use this panel to assign specific IP addresses ta this server,
leawing the other addresses available for other senvers,

l Do wou want the Directary Services serverto use all IP addresses?

 Yes, use all IP addresses

& Mo, use only the following IP addresses:

95827
94 61.216 Select all |
§95.61.228
9.5.149.145 Deselect all |

| 9.5.149.150
45149156
4.5.149.230
109141

127.0.0.1 =

ﬁElack ’Nem | xoancel |
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Autostart the server

Directory Services Configuration Wizard - Specify TCPSIP Preference

Do you want the directory server to start each time TCPIP is started?

Mo

ﬁEIack ‘Nex‘[ | XCanceI |
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Publish user and system information

Directory Services Configuration Wizard - Specify Information to Publish

The system can publish certain types of infarmation to the LDAP directory server. Users
can then use LDAR clients to access the information.

=

Which types of information do you want the systerm to puhlish to the directary semvery

¥ Systern

ﬁ Back * Mext | x Cancel
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Final summary

Directory Services Configuration Wizard - Summary

You have completed all the steps necessary to canfigura the LDAR directory senver,

l [Tyou want to change any settings, click Back. To save the directory configuration, click
Finish. Far more information an the directary settings, click Details.

Setfting | Yalue ||
Datahase library: IQ8YS.LIBMUJSRDIRDE.LIB
Administrator Dk; system generated
Fassuword: systerm generated
Directory Suffixes: de=rchasyym,de=rchland de=ibm,dc=com
IP addresses to use: 95821
Start server when TCPIR is started: Yes
Infarrmation to publish: lsers
System

Details |

ﬁElack | “Finish xoancel |
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Final summary - Details

Directory Services Configuration Wizard - Summary

This panel summarizes the following configuration settings thatvou have chosen foryour LOARP directory server;

N The disk poal that cantains the library that stores the LDARP directons database files. This field is
Disk pool ) . .
only displayed if your systern has more than one disk poal.
" The database library that containg your LDAP directon's information. This field is only displayed if
Ul you configure your LDAP directory with default settings.
Administrator DN The digtinguished name ;DN_J Fhat has unfestncte_d arcess to the entire directory, Ifyou sglected
System-generated, the administrator DM iz not displayed, because only the server uses it
Password The password that is used by the Administrator D,
Directory Sufiixes Lists the directony's suffixes, which determine which ahjects in the directary that this LDAF directany
SEMer Can access.
Start server when Indicates whether the LDAR directory server iz automatically started each time that TCRAF starts on
TCPAP is started yaur system.
N . Specifies the types of information that yvour systerm will automatically publish to the LDAF directony,
UL L O Mote: this field is not displayved if publishing was configured prior to running the wizard.
Publishing DN The suffix that will he used as the stading point when GE/400 pablishes information to the directory.
Mote: this field is not displayed if publishing was configured prior to running the wizard.

Mote that unless have previously associated a digital certificate with the Directary Services server application,
connections to your LOAP directory server are initially not secure. See the iSeries 400 Information Center for
information on securing your LDAP server with secure sockets layer (S50,

To save the directory configuration, click Finish. To change any settings, click Back.
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Configuring the Server

©:2003 IBM Corporation



IBM eServer iSeries

¥ iSeries Havigator
Fil=  Edit

YWiew Help

After initial configuration

PO E N IES

| Ervironment; My Connections

! Lpar2nzm

E- @ Lpar3nzm

E|! Rchasysm

% B azic: Operations

£ work Management

B Configuration and Service
=L Metwork

% TCP/IP Configuration

[

Remote Access Services

Elﬁ Servers

L LT TCPAP

ik i5enes Acoess

=g DNS

ﬁ User-Defined
7 1P Policies
L T e .

Add a connection
(&) Install additional components

11 minutes old
| Rchasysm: TCR/AP
Semver Mame | Status | Dezcription ﬂ
ﬁﬁ DILFR Stopped Datahnks File Server
=ﬁg\-"irtual Private Metworking Stopped Wirtual private networking
T3 ASFTomcat Started ASFTomcat server
?E Triggered Cache Manager Stopped Triggered cache manager
HaFTP Started FTP
HaLFD Started LPD
HaPoP Stopped POP
ﬁﬁ Fiemate Esecution Stopped Remate execution
A SMTP Started SMTR
T3 TELNET Started TELMET
ﬁ'ﬁ_' HTTP Administration Started HTTF administration
m Stopped Directory
« Start
S
- Server Jobs

Create a new DNS Mame Server
ﬁ Configure spstem as DHCP server

Configure subsystems for zerver jobs i

o Configure spstem as Directony
¥ D Help for related tasks

Reconfigure -
Autharity

SEL Hraups
Eesarmest.
Status

Properties

| [18- 29 of 29 ohjects

Ewport File

e
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Configuring the Server

= Reconfigure
» Use configuration wizard to replace current configuration.

= Authority
» Controlling access to subtrees, data entries, and attributes.

= ACL Groups
» Create/update groups and group membership.

= Properties
» Changing the LDAP administrator password.
» Creating new suffixes.
» Selecting the ports.
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Authority

. Rchasyxm - Authority [CE0=]

Select a directory object and click on the Edit Autharity button.

g Directory on RCHASY XM
=

L pn=audit

Edit Autharity I

Directory is using access-class level permissions.

Enahle attribute-level permissions... |
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ACL Groups

Mew ACL Group - RCHASYXM E3

Relative Dk for new group;

ACL Groups - RCHASYXM ] |en=BethsGraup

Type:
IAccess graup LI

Access control groups defined an this server;

Select location far new group:

Celete B RCHASYHM
- [i® 5 m,dc=rchland de=ibm,de=corm

Members...

Il

Ok | Cancel | Help |‘?|

[0]:4 Cancel Help |7|
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Properties: General

Directory Properties - Rchasyxm EHE
General | Databa&efﬁuffixesl Heplicationl Networkl Perfnrmancel .&uditingl Kerbero&l Event&l Transactioml
LOAP protocol vergion: 3
¥ iStart server when TCP/IP is started
¥ allows directoy updates
Schema checking: {3 [lenient) =]
— ddministrator information
Adminiztratar name: Icn=admin Password... |
[~ Grant administrator access to authonzed users.
— Refernals
ove Up |
owe e |
Add
Edit |
Hemove |
)4 I Cancel Help
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Properties: Database/Suffixes

Directory Properties - Rchasyxm I

General Database/Suffives IHepIicatinnI Netwnrkl Perfnrmancel Auditingl Kerbernsl E\-'entsl Tran&actinnsl

Browse... |

[ratabaze libran:

Database connections and server threads (4 - 32): 4 _:I

— Suffises

Mew sulfix: A

de=rchasyxm do=rchland, de=ibm,dc=com

Eemove |

— Syztem objects suffix
i ozd 00-syz=rchasysm. rehland.ibm. com

— Change log
[ Log directary changes

b arimurn entries: Mo lirnit j

0k, I Cancel Help
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Properties: Replication

Directory Properties - Rchasyxm

Generall Databasze/Suffives  Replication | Netwolkl Performancel .t'-\uditingl Kerberosl Eventsl Transactionsl

—Azsociated replicas

Servers containing replicas of data an thiz zerver

Infarmation not available when server iz stopped. Sdd)

Eemoye

[oefarz.

" Use as a replica server

Il ame weed|yimastenserers (o ipnates:

A

j Fagzspandt.

fiasten sepen I EL:

] I Cancel

Help
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Properties: Network

Directory Properties - Rchasyxm !EE

Generall Databaseiﬁufﬁxesl Replication NBT'ND"

— Connections to allow

[+ Mot secure IP Addresses. |

Port: 389

¥ Secure Sockets Layer (S50
Fort: [l

Authentication methods:
& Server authentication

" Client and server authentication

— Manage digital certificate assigned to directary serer

Digital Certificate Manager |

Advanced... |

ok | cancet | wmew |7]
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Properties: Network->IP Addresses

Directory - IP Addiesses

* Use all IP addresses

" Use selected IP addresses

Directory server IP addresses:

.58
9.5.8.27
4.5.61.216 Selectall |
9.4.61.228 |

95149145 Eeselectall
551491450

551491456

55149230

1049.1.1

127.0.0.1

014 Cancel | Help |‘?|
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Properties: Network->Advanced

Directory - Advanced Network Properties E3

— Protocaols

v Use default protocols

¥ Triple BES SHE (68 bit) ¥ | BES SHE (56 ity
¥ REASHE (1128 bity ¥ | B3 G A kit
[ R i m (1 28 it [ | B A r o (a0 it

2 AES (1 281 ity

— Passward protection
 Mone
& SHA
MDA

 Crypt

014 Cancel | Help |‘?|
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Properties: Performance

Directory Properties - Rchasyxm M= B

| Auditingl Kerbemsl Eventsl Transactinnsl

Maxirmum search size: ISIZIIZI j entries

Maxirmum search time: IQDD ;I seconds

ok | cancel Help ||
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Properties: Auditing

Directory Properties - Bchasyxm M=

Generall Database!Sufﬂ}{esl Replicatinnl Netwnrkl Fetfarmance

| Kerberosl E\rentsl Transactinnsl

— Directary entry auditing
& MNone

¢ Changes o enfries

& Any access of entries

ok | cancel | Hew |7
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Properties: Kerberos

Directory Properties - Rchasyxm [ [=) x|

Generall Database!Sufﬁxesl Replicatinnl Netwcnrkl Perrormancel Auditing KEFbEfDl Eventsl Transactinnsl

[~ Enable Kerberas authentication

Eerteros eyiakiile:

l@IEIMIUserDataIOSatDDINetworkAuthentiu:atinnlkewahlkrbﬁ.kexrtab

— DM to use for connections

Hrawse... |

) Search direstony far Ewith Kerberos attribiite

%] Create D fram Kertheros ([

— Kerberas Adrministrator D

] =

INone

EEa|

IDEPTGBRRCHLAND.IEIM.COM

o< 1]

Cancel

Help |2]
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Properties: Events

Directory Properties - Bchaspxm _ [S] =]

Generall Database!Sufﬁxesl Replicatinnl Netwcnrkl Perrormancel Auditingl Ketheros

[ Allow clients to register far event notification

Maximum registrations for each connection:

IND maximum
Maximum server registrations:

IND maximum

Ok I Cancel

Help ||
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Properties: Transactions

Directory Properties - Bchasyxm M=

Generall Database!Sufﬂ}{esl Replicatinnl Netwnrkl F'errnrmancel Auditingl Kerberosl Events

Maximum transaction size (2 - 100 |5 ::I operations
Maximum pending transactions {0 - 100} IED ::I transactions
Transaction time limit; |5 ::I minutes

ok | cancel | Hew |7

©:2003 IBM Corporation




IBM eServer iSeries

Managing the Server
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¥ iSeries Havigator
Fil=  Edit

YWiew Help

After initial configuration

PO E N IES

| Ervironment; My Connections

! Lpar2nzm

E- @ Lpar3nzm

E|! Rchasysm

% B azic: Operations

£ work Management

B Configuration and Service
=L Metwork

% TCP/IP Configuration

[

Remote Access Services

Elﬁ Servers

L LT TCPAP

ik i5enes Acoess

=g DNS

ﬁ User-Defined
7 1P Policies
L T e .

Add a connection
(&) Install additional components

11 minutes old
| Rchasysm: TCR/AP
Semver Mame | Status | Dezcription ﬂ
ﬁﬁ DILFR Stopped Datahnks File Server
=ﬁg\-"irtual Private Metworking Stopped Wirtual private networking
T3 ASFTomcat Started ASFTomcat server
?E Triggered Cache Manager Stopped Triggered cache manager
HaFTP Started FTP
HaLFD Started LPD
HaPoP Stopped POP
ﬁﬁ Fiemate Esecution Stopped Remate execution
A SMTP Started SMTR
T3 TELNET Started TELMET
ﬁ'ﬁ_' HTTP Administration Started HTTF administration
m Stopped Directory
« Start
S
- Server Jobs

Create a new DNS Mame Server
ﬁ Configure spstem as DHCP server

Configure subsystems for zerver jobs i

o Configure spstem as Directony
¥ D Help for related tasks

Reconfigure -
Autharity

SEL Hraups
Eesarmest.
Status

Properties

| [18- 29 of 29 ohjects

Ewport File

e
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Managing the server with iSeries Navigator

= Start
» Starts the server when it is stopped.

= Stop

» Stops the server when it is running.

= Server Jobs
» Opens another window showing the status of the jobs running on the iSeries.

= Tools->Import File
» Imports data into the directory from an LDIF file.

= Tools->Export File
» Exports data from the directory into an LDIF file.

= Reconnect
» Allows an administrator to reauthenticate to the server.

= Status
» Shows information about server activity since last started.
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Server Jobs

I Server jobs for Directory - Rchasyxm
File Edit “iew Help

BN X FECE

0 minutes old

| Status: Active jobz

Fun Thread
Job Mame Current User | Detailad Status Server Friority Count
& Cldirzre Completed - Printer output awvailable Diirectony 0 i}
& Cldirzry Cdirzre W aiting for zignal Directony a0 10
& Odirsrv Cornpleted - Printer output available Drirectony 0 I}

[ [1- 3 of 3 objscts
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Tools->Export File

T Export Directory to LDIF File - Rchasyzm

Mame of LDAP Data Interchange Format [LDIF] file to export directory
b

|| Browse...

Select portion of directom to export;

" Export selected subtree

Browse...

% Export entire directony

Thiz operation may take a long time.

] I Cancel Help
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Status: Summary

5 Directory Server Status - Bchasyzm

0 minutes old
- Summary | Connections
Connect to Directory Server Eq

. Status: Started atFeb 18, 2003 14599 FPM
Directory server; RCHASY XM

o . Current number of threqds: 1
Distinguished name:; Icn:admm
— Password Requests: 7

= Password: I’HHHHHr Requests completed: 7

™ Use system passward Event registrations: 0
— ErrmEETE Muotifications sent: 0

[0 Use secire connecion

(0] I Cancel Help 7
Refresh Mow Timed Refresh... |
Ok | Cancel Help |‘?|
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Status: Connections

T Directory Server Status - Rchasyxm M= B
IIZI minutes old
Summary Cunnectiunsl
Connections: 1
Active connections: 1
Blocked on read: 1]
Blocked on write: 0
Distinguished Mame | Connect Time | Completed Reguests |Active Requests | Blocked |_|
ChH=ADMIMN Feh 18,2003 1:48:05 PM 12 1
Refrash Mo I Tirmed Refresh... |
[0]:4 | Cancel Help 7
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Controlling Access
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Ownership

= Each object in your directory has one or more owners.
= Object owners have the power to delete the object.

= Owners and the server administrator are the only users that can change
the ownership properties and the access control list (ACL) attributes of
an object.

= Ownership of objects can be either inherited or explicit.
» Explicitly set up ownership for a specific object.
» Specify that objects inherit their owners from objects higher up in the directory
hierarchy.
= You can also specify that an object owns itself.
» Specify a special DN cn=this in the list of object owners.

» Example: if object cn=A has owner cn=this, then any user will have owner
access to the cn=A object if he connects to the server as cn=A.
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LDAP ACLs and Groups

= ACLs control who may add and delete directory objects.

= ACLs control who may read, write, search, and compare directory
attributes.

= ACLs can be either inherited or explicit.
» Explicitly set up an ACL for a specific object.

» Specify that objects inherit ACLs from objects higher up in the directory
hierarchy.

= ACL groups can simplify granting authority if the same set of users
requires access to the same set of objects.

= ACL groups allow you to grant access to specific groups of users rather
than granting authority on an individual basis.
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Controlling Access: General

= You can manage access to directory data from iSeries Navigator - or
any LDAP application by modifying the proper attributes

= |IBM specific - currently no standards define a LDAP access control
model, but most vendors provide something

= Access defined in terms of:
» subject: the authenticated identity of the client, determined at bind time
» rights: the permissions granted to a subject or group
» object: the entry being accessed

= |BM access control model defines owners and an access control list
» Both can apply to a set of objects (a subtree) or a single entry
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Controlling Access: General

= Special DNs that can be used
» cn=anybody - all clients, including anonymous
» cn=authenticated - everybody but anonymous
» cn=this - client must be authenticated as the entry to which this applies

= Owner has complete access to the entry
» Owner can be a group
» Entries can inherit ownership
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Authority

. Rchasyxm - Authority [CE0=]

Select a directory object and click on the Edit Autharity button.

g Directory on RCHASY XM
=

L pn=audit

Edit Autharity I

Directory is using access-class level permissions.

Enahle attribute-level permissions... |
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Controlling Access: Owner

T+ Edit Authority - dc=rchasb10.dc=acme.dc=com 0] x|
Crhiher | AcL]
Directory ohject; de=rchashl 0 de=acme,dec=com
— Owener
" Inherited
Source: Default directory authority
 Explicit
Add owner. = Add
Browese...
Owners: ch=administratar
Eermoyve
[+ Propagate owner to lower level ohjects
]9 Cancel Help ¢
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Controlling Access: ACLs

= Access Control List grants permissions to others

» attributes assigned to an "access-class”
- NORMAL (cn, sn, telephoneNumber, ...)
— SENSITIVE (homePhone, homeFax, ...)
— CRITICAL (userPassword, userCertificate, ...)

» grant write, read, search, compare permissions to attributes
» grant add and delete permissions to objects that the ACL applies to

= VV5R1 adds attribute level access control
» grant or deny access to specific attributes
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Controlling Access: ACLs

T+ Edit Authority - dc=rchasb10.dc=acme.dc=com - 0] x|
Chner ﬁCLl
= Inherited ACL

Source; Diefault directory authority

[v Propagate ACL to lower level objects

Access control list entries:
ch=anybody Add.

Eermove

etails...

]9 Cancel Help ¢
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Controlling Access: ACLs

Add ACL Entry X|

Obiect | atributes |

Directory object; dr=rchasa10,de=acme, do=com
User: ch=John Mchﬂeeking,cn:users,dc:acj Browse. |

Ohject permissions:

Addd: |Un5peciﬂed =l

Delete: [Unspecified =
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Controlling Access: ACLs

Add ACL Entry X|

Directory object: de=rchass10,de=acme, de=cam

zer: ch=John Mcheeking, cn=users,de=acme, ...
Legend:

[ Unspecified [+ Grant [= Dery

Aftribute permissions:
Access Class Fead | Wite | Search | Campare |J
[+ [+ [+ [+

Sensitive [+ [+ [+ [+
Mormal [+ [+ [+ [+

Aftribute specific permissions:

Atftribute Read | Wilrite | Search |Cnmpare |J
[+ [+ [+ [+

userPassward

Add...

Rermaove |

Grant All Dy All | Clear All |

ok | cancel | Heln 7]
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Controlling Access: Groups

= Groups can be used as the "subject" for access control

» Each of the "group" object classes defines membership via the "member"
attribute

» Member can be a LDAP entry or a pseudo-DN
— Kerberos: ibm-kn=jmcmeek@acme.com
— Digital Certificate: subject DN from certificate

» Cannot nest groups for access control

= |nitial release supported two "group" objectclasses that could be used in
access control: accessgroup and accessrole.

V5R1 also supports groupOfNames and groupOfUniqgueNames

= You can manage groups via DMT, Operations Navigator (accessgroup
and accessrole), or any LDAP client
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ACL Groups

Mew ACL Group - RCHASYXM E3

Relative Dk for new group;

ACL Groups - RCHASYXM ] |en=BethsGraup

Type:
IAccess graup LI

Access control groups defined an this server;

Select location far new group:

Celete B RCHASYHM
- [i® 5 m,dc=rchland de=ibm,de=corm

Members...

Il

Ok | Cancel | Help |‘?|

[0]:4 Cancel Help |7|
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Controlling Access: ACLs

MNew ACL Group - RCHASA10

Eroup:
Zammon hame:

Type:

|[:n=user administrators, de=rchasal 0,de=acme, dc=caom

|useradmini5tratur5

ACCESS Qroup

Members

mMemberto add:
= | add—»
Directany: BN
RCHASS10

de=rchasa10,de=acme, do=co

Im

ch=John Moheeking,ch=users, dec=acme,dc
cn=Marla Berg,cn=users, dc=acme, dc=com

Kl -

0] | Cancel | Help |‘?|

dn: cn=user administrators,dc=rchas510,dc=acme,dc=com

objectclass: accessgroup
objectclass: top

member: cn=John McMeeking,cn=users,dc=acme,dc=com
member: cn=Marla Berg,cn=users,dc=acme,dc=com

cn: user administrators
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Publishing
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iISeries Navigator: Properties

£ i5enes Navigator
File  Edit “iew Help

* ﬂ| }(|@@' 0 minutes old

| Enviranment: My Connections | Fichazysm:
! LparZnzm ;I Hame | Description
! Lpar3nam Qﬁ- B azic Operations Manage mezzages, printer output, printers, and jobs.

- @Wnrk td ahagement Manage active jobs. server jobs, job queues, subspstems, and
Y% Basic Operation S &5 Configuration and Service Dizplay system inventony, wark, with fises, and collect performar
B work Managem  dpen o £ Netwark Manage TCPAP and Internet support.
gﬁ Configuation ar Eustumge istian et Security Configure and manage security.
El NEW;E;-’IP ool Caiectily i ggre | 8% U sers and Groups Manage 05 /400 uzers and uzer groups.
% Remote Ao Run Command... % Databazes Administer DB 200
Eﬁ Servers Send Meszage. .. @7, File Syztems whork, with file systems.
P ﬁ _T':F.""IP Uzers and Groups »
E iSeries £ Inventory »
i Dl Fixes r
i U.SE:'I'DE Collection Services  »
@ IP Policies

Systern Status

Ll [-|Connection tasks
! Add a connection Properties .@, Fun a command ! Change your server password
& Install additional components 22 Install additional components Il“l Wiew zpztem statuz
& Instal plug-ing b ? Help for related tazks

B Configure connection security and perfam

| [1 -8 of & chiects

W
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Directory Services

Rchasyxm Properties M= B

General| Connection| Licenses | Restart Directory Serices | Service | Plug-ins |

Infarrmation to publish on LDAP directory server:

Infarmation | Directory Server | Parent DM
sers rehaswdmerch... cn=users,C
System

Print Shares

TCRIF Guality o ice Policies _—

Easswan.

Server Jobs |

oK cancel | Heln |e]
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User Information

Zonfiguration |

¥ Puhlish user infarmation

—WWhere to publish

Directory servar: rehaswdm.rehlandibm.com Edit |
Under DM PHASWM,DC:RCHLAND,DC=IEIM,DC=COM|j Browse. . |

— Berer connection

¥ Use Secure Sockets Layer (S5L)

Port: 636
Authentication methad: IUse D and password ;I
Distinguished name: |cn=administramr

Set Password... |

Watify |

oK cancel | Heip |e|
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Example: Published User

C:\>Idapsearch -h myiseries -b "cn=users,dc=myiseries,dc=com" "(sn=hoffman)"
cn=Beth L Hoffman,cn=users,dc=myiseries,dc=com
objectclass=top

objectclass=person
objectclass=organizationalPerson
objectclass=inetOrgPerson
objectclass=publisher

objectclass=ePerson

cn=Beth L Hoffman

cn=Beth Hoffman

cn=BETHVH

sn=Hoffman

uid=BETHVH

givenname=Beth

description=BETHVH

title=0S/400 Directory Services
departmentnumber=G8RA
telephonenumber=(507)253-3627

roomnumber=J119

registeredaddress=3605 Highway 52 NW Rochester, MN 55901
mail=bethvh@US.IBM.COM
publishername=dc=MYISERIES, dc=COM
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System Information - Configuration

Configuration | Printersl

¥ Publish swstem infarmation

—Where to publish

Directory server: Edit |
Under DR; l j Browse. .. |

— Berver connection

[ Use Secure Sockets Layer (S5L)

Port: 2849

Althentication method: IUse DM and passward ;I

Distinguished name: I

SetPasswordl |

Warify |

oK Cancel Help ||
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System Information - Printers

System Information Details

Configuration F'rintersl

Awvailable printers: Printers to publish:
5 DPLWWIIE 8 DBYHM

5 IPPSSL

@ IPPSSLPRI

5 IPFTLS

Add All --=

Remowe =-

Remowe All <--

_Remor |
| spavae

oK cancel | Hen |2]
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Print Shares - Configuration

Configuration | Print Sharesl

¥ Puhblish print share infarmation

—Where to publish
Active Directory server: Edit |
Under DM; ;l Browse. .. |

— Sener connection

[ Use Secure Sockets Layer (SSL)

Faort: 389
Authentication methaod: IUse O and password LI
Distinguished name: l

EETEEEEH ES |

Warify |

oK cancel | Heln |e]
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Print Shares - Print Shares

Print Share Information Details Eq

Canfiguration

Awailabile print shares: Frint shares to publish:

Al =

Al Al ===

BErmayel =

LLL

FermEyesll ===

ok | cancel | Hew |7
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TCP/IP QOS

TCPAIP Quality of Service Policy Information Details

Coanfiguration |

[ Puhblish TGPAP Guality of Service palicy information

—Where to puhlish
Edit

v| Browse...

Search...

Directory server

Under DMN:

ik

—Server connection

[ Use Secure Sockets Layer (SSL)

Faort: 380

Authentication method: IUSE Ol and password ;I

Distinguished name: I

EE TR S eI B |

Warify |

0K cancel | Hein 2|

©:2003 IBM Corporation




IBM eServer iSeries

Tools for Accessing the Directory
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Tools

Pointing your address book at an LDAP server
IBM Directory Management Tool (DMT)

Command line utilities

= [Series Navigator for management of access control
Other tools
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Pointing your address book at an LDAP server

= Accessing the LDAP server via Outlook Express (similar for other e-mail

clients)

» Launch 'Find People’
» Right Click on "Look in:" to select "Directory services"

% Find People

Look ir:
Feople |

M amne:
E-mail:
Address:
Fhote:

Other:

I.ﬁ.ddress Book

-

Directory services

'*“'ﬂ"-lSite. .

Froperties

Mo

Stom

Clear All
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Address book setup

= Click "Add..." in Internet Accounts window

Internet Accounts 2=l

Directay Service | Add...

Account | Type | Connection | Remove |
L2 iActive Directorny directory service Local &rea Metwork -

@ Bigfoat Intermet ... directony service Local Area Nebwork Properties |
@ BluePages . d?rectury sew?ce Ay Ayvailable R |
@ InfoSpace Buzin..  directony service Local Area Nebwork

@ InfoSpace Intern...  directony service Local Area Nebwork Impart... |

@ Switchboard Inter...  directory service Local Area Network
@\-"eriSign Internet .. directony service Local Area Nebwork Export.. |
@Whu‘w"here Inter...  directony service Local Area Network
%Yahuo! People 5. directony service Local Area Metwork

Set Order... |

Cloze
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Address book setup

= Fill in Server name and continue to end of wizard

Internet Connection Wizard

Internet Directory Server Hame

Type the name of the Internet directony [LDAR] zerver your Internet zervice provider o

zpztem adminiztratar has given pou,

Internet directam [LDAP] zerer: II::Iap.an::me.n:n:lm

If your Intermet service provider or gystem adminiztrator has informed you that they

require you to log on ko vour LOAP server and has provided pow with an LOAR account

hame and password, select the check box below,

[ My LDAP zerver requires me to log on

< Back Hext =

Cancel

©:2003 IBM Corporation
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Address book setup

= After completing the wizard, select the server in the "Internet Accounts"
window and click Properties. Go to advanced tab and fill in parent DN
where users are published:
% |par?nzm Properties i 21x

General .ﬁ.dvancedl

Server Port Mumber

Directomn service [LDAPY; IEEE! Use [efault |

[ This zerver requires a secure connection [S5L]

Search

Search imeout;
Shatt —F—— Lang 1 minute

b asirmum number of matches b return; 100

Search base:

CN=USErs, 0=3cme, C=Us

[T Usze simple search filker

Ok Cancel &pply
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Address book setup

= Now look for someone in the directory:

% Find People 21x

Look ir: IIparEnzm j Wieh Site,..

Feople |.ﬁ.dvanced|

Eind Mo
MHame: IJl:uhn Mchesking
Stop
E-muail; I
Clear All

©:2003 IBM Corporation




IBM eServer iSeries

Address book setup

= Or maybe try an advanced search:

" Find People - (1 entries found) 2|
Loak in: IIparEnzm j el Site...
People Advanced |
— Define Criteria ey
Last Mame j Istarts 1with j Imn:m Stop
Last Mame starts with micm fadd Clear &l
Remove %
Cloze
Mame | E-t all Addresz | Business Propertiez
iohn & Mohkeeking imcmesk @S BM.COM (607253
Lelete
Add bo Addrezs Book
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Using DMT

B idapircRas AT A

_4 Introduction
=4 Server
- [ Properties
[ Status
- [ Administration
e EI Rehind
=4 Schema
- [ Refresh schema
@[] Object classes
-] Attributes
- [ Matching rules
o [y Byntaxes
=4 Directory tree
[y Browse tree
- [ Refresh tree
= 4 Search tree
- [ Simple search
“ [y Advanced search
=4 Log file
o 1y View log file
L@y Clear log file

Add server Delete server | Exit |

< |IBM SecureWay Directory Management Tool

Introduction

Ready

IBM SecureWay Directory Management Tool

|BM SecureVay Directory is a Lightweight Directory Access Protocol
(LOAPY directory that runs as a stand-alone daemaoan. ltuses a
client'server model to provide LDAP clients access to the LDAP
Server.

This java client-hased interface allovws the administrator to maintain
LOAP directaries on multiple LDAP servers.

This interface supports the following functions:
L Displaying semer properties and rebinding to the server

Listing, adding, editing, and deleting schema attributes and
ohject classes

L Listing, adding, editing, and deleting directary entries
L Madifying directory entry ACLS
L Searching the directory tree

At any time, you can select

? in the upper right corner to access help
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Using DMT

= |nstall the IBM Directory Client SDK

» from your iSeries machine:
/qibm/proddata/os400/dirsrv/usertools/windows/setup.exe

» Or download from the IBM Directory web site:
http://www.ibm.com/software/network/directory/downloads
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Using DMT - Create an entry

= Click "Browse tree", then the "Add" button

< IBM SecureWay Directory Management Tool

B Idapidirchass10:389 | Browse tree

4 Introduction
(=4 Server Ready

[ Properies
= | % |a|lew| & | v |@| =

0y Status
Search Expand Ad Edit Do licate Delete AL Edit FLEH A

= [ Administration
- 3 Rehind
E- 9 Schema
- [ Refresh schema
_| Objectclasses
) Attributes
- [ Matching rules
- [ Syntaxes
-9 Directory free
- [ Browse tree
- [ Refresh tree
=9 Search tree
----- [y Simple search
“o [ Advanced search
-9 Log file
o [y View log file
l'_“. Clear log file

ﬁ Idap:irchass10; 389 |

---dc=rchasﬁ1El,dI::al:me,dc:cnm
F-cn=localhost

Add server Delete server | Exit
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Using DMT - Create an entry

= Select the object class -- commonly used ones, like "organization", are

listed in the dropdown, or chose "Other"

= Enter Parent DN (c=us) and entry DN (o=acme). Even though there is

no c=us entry, DMT will combine these to get "o=acme,c=us"

< Add an LDAP Entry

Select an Entry type, enterthe Parent DM, modify the Entry RDM, then click Ok,
Entrytype  |Organization |

Parent DM jc=us

Entry RDM:  jo=acme|

0] Cancel Help

©:2003 IBM Corporation
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Using DMT - Create an entry

= Fill in any other information you might want to provide here, and click
IlAddll

< Add an LDAP Entry x|

To add & new entry, enter values for the attributes, then click Add.

ohjectClass {Object class): arganization

dn (DM jo=acme, c=us

Attributes

|»

o jacme

businessCategory;

description:

destinationindicatar:

facsimileTelephoneMumber:

internationallSCMMumber:

physicalDeliveryOfficebame:

postalAddress:

200 Q000 Q@

postalCode:
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Using DMT

= View or edit schema

< IBM SecureWay Directory Management Tool -0 x|

B Idapchass10:389 | View object classes

4 Introduction

=4 Server

----- [y Properies

- [y Status

- [ Administration
“ 3 Rehind

E- 9 Schema

- [y Refresh schema
=4 Ohject classes

Gy = Ed i Sartby: [Mame I

Search Add Edit Celete

T

CS400MCIARpplication

e
Bl

- @
- [ \iew ohject classes ~@ 0S400PTF
[ Add object class ~@ 054005 0ftware
[ Edit ohject class E""
. B- Optlnnal attributes
B Qelete ohject classes - description
-] Attnt:ngtes - zoaAlso
""" & Matching rules ~telephoneMumber
- Syntaxes - UgerPassword
=4 Directory tree = Required attributes
----- O Browse tree L
----- O Refresh tree 11!
=4 Searchtree | W] - Description : 'Defines entries that generically represent people.’
O Simple search B} Chject class name . ‘persan’
- Advanced search | B OID - 2568
=E-CqLogfile | #l Superiorobject class © top J
- [y View log file - W pilotDSA,

-1 pilotObject
-l pilotOrganization

[#- e printerAbstract -
4 I b

“e- [ Clear log file

Add server Delete senver | Exit
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QSHELL Utilities

LDAP command line utilities can be invoked from QSH:
» |dapadd, Idapmodify, [dapsearch, Idapdelete, Idapmodrdn

Utilities accept input from standard input or from a file

Search output can be redirected to a file

= Can be invoked from CL or a program
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QSHELL Utilities

= |dapsearch examples
> ldapsearch -h rchasb5l10 -D cn=administrator -w secret -b "DC=LPAR2NZM, DC=RCHLAND, DC=IBM, DC=COM"

" (sn=mcmeek*)"

cn=John A McMeeking, cn=users,dc=rchas510,dc=acme, dc=com

objectclass=top

objectclass=person

objectclass=organizationalPerson

objectclass=inetOrgPerson

cn=John A McMeeking

sn=McMeeking

uid=JAM

givenname=John

PGM

QSH CMD ('ldapsearch -h rchas510 -b "" -s base " (objectclass=*)" > rootdse.out')
ENDPGM

CALL QSYS/QGLDSEARCH PARM('-h' 'rchas510' '-b' '' '-s' 'base' ' (objectclass=*)")
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LDIF Files

= LDIF is the LDAP data interchange format; an industry standard.

= Way to transfer directory data between LDAP servers; export from one,
import into another.

= Simple text file format.

= Sequence of lines that describe either an entry or a set of changes to an
entry.

= The order of entries in the file is important.
= To add an entry, the parent entry must first exist in the namespace.

= The specific format and contents of the LDIF file are determined by the
schema.

= The servers used for export and import need to support the same part of
the schema.
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Example LDIF File

= Contents of mods.Idif:
dn: cn=john mcmeeking, cn=users,dc=acme,dc=com
changetype: modify
add: userpassword
userpassword: secret

dn: cn=mary jones,cn=users,dc=acme,dc=com
changetype: add

cn: mary Jjones

sn: jones

telephonenumber: 555.5555

dn: cn=paul smith,cn=users,dc=acme,dc=com
changetype: delete
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QSHELL Utilities

= |dapmodify examples

» Can be used to add, modify, delete and rename entries via 'changetype'
directive.

» Example using an LDIF file.

> |dapmodify -D cn=administrator -w secret -f mods.Idif
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Summary

= You've learned:
» LDAP terminology and advanced concepts
Authentication methods
How to configure the server the first time using the wizard
How to start and stop the server
Access control and groups
How to publish information to the server
Examples of entries and LDIF files
GUI tools for accessing and managing the server

= What's next?

» Gain hands on experience now
— 440178: OPEN LAB: IBM Directory Server (LDAP)

» Back at the office
- Design a simple directory, configure your LDAP server and create your first directory

» Read advanced information

©:2003 IBM Corporation
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LDAP Open Lab

= 430242: LAB: IBM Directory Server (LDAP)
» Start and stop the server

Configure the server

Search entries in the directory

Create a suffix and add new directory entries

Work with directory data (delete/modify)

Import/export data using LDIF files

Use DMT

Work with the schema

» Work with the changle log

= 440144: LAB: Using LDAP Authentication with Apache
» Create an HTTP server
» Configure HTTP server to connect to LDAP server
» Protect a web page using LDAP authentication

©:2003 IBM Corporation
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For More Information

= iSeries LDAP home page: www.ibm.com/eservers/iseries/Idap

= iSeries Information Center
» Networking -> TCP/IP -> Directory Services (LDAP)
» Programming -> CL and APlIs -> APls, look for Directory Services in APIs by category

= |IBM Directory Server home page: www.ibm.com/software/network/directory/

= Redbooks: www.redbooks.ibm.com
» SG24-4986-00 Understanding LDAP
» SG24-5110-00 LDAP Implementation Cookbook

» SG24-6163-00 Using LDAP for Directory Integration: A Look at IBM SecureWay
Directory, Active Directory, and Domino

» SG24-6193-00 Implementation and Practical Use of LDAP on IBM eServer iSeries
(draft Redbook available as a Redpiece)

= Java programming using JNDI, read Sun's JNDI tutorial section "Tips for LDAP
Users": java.sun.com/products/jndi/docs.html

= "e-Directories Enterprise Software, Solutions, and Services. ISBN
0-201-70039-5. Published by Addison-Wesley Professional.
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Appendix

= LDAP - Lightweight Directory Access Protocol
= RFC - Request for Comments

= LDIF - LDAP Data Interchange Format

= API - Application Programming Interface

= PKI - Public Key Infrastructure

= CRL - Certificate Revocation List

= EIM - Enterprise Identity Mapping

= SDD - System Distribution Directory

= QOS - Quality of Service
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Trademarks and Disclaimers

© IBM Corporation 1994-2003. All rights reserved.
References in this document to IBM products or services do not imply that IBM intends to make them available in every country.

The following terms are trademarks or registered trademarks of International Business Machines Corporation in the United States, other countries, or both:

AS/400 IBM

AS/400e IBM (logo)

eServer iSeries
@server 0S/400

Lotus and SmartSuite are trademarks of Lotus Development Corporation and/or IBM Corporation in the United States, other countries, or both.
MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel Corporation in the United States, other countries, or both.
Microsoft and Windows NT are registered trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction LLC.

C-bus is a trademark of Corollary, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product or service names may be trademarks or service marks of others.

Information is provided "AS IS" without warranty of any kind.

All customer examples described are presented as illustrations of how those customers have used IBM products and the results they may have achieved. Actual environmental costs and
performance characteristics may vary by customer.

Information in this presentation concerning non-IBM products was obtained from a supplier of these products, published announcement material, or other publicly available sources and
does not constitute an endorsement of such products by IBM. Sources for non-IBM list prices and performance numbers are taken from publicly available information, including vendor
announcements and vendor worldwide homepages. IBM has not tested these products and cannot confirm the accuracy of performance, capability, or any other claims related to non-IBM
products. Questions on the capability of non-IBM products should be addressed to the supplier of those products.

All statements regarding IBM future direction and intent are subject to change or withdrawal without notice, and represent goals and objectives only. Contact your local IBM office or IBM
authorized reseller for the full text of the specific Statement of Direction.

Some information in this presentation addresses anticipated future capabilities. Such information is not intended as a definitive statement of a commitment to specific levels of
performance, function or delivery schedules with respect to any future products. Such commitments are only made in IBM product announcements. The information is presented here to
communicate IBM's current investment and development activities as a good faith effort to help with our customers' future planning.

Performance is based on measurements and projections using standard IBM benchmarks in a controlled environment. The actual throughput or performance that any user will experience
will vary depending upon considerations such as the amount of multiprogramming in the user's job stream, the I/O configuration, the storage configuration, and the workload processed.
Therefore, no assurance can be given that an individual user will achieve throughput or performance improvements equivalent to the ratios stated here.

Photographs shown are of engineering prototypes. Changes may be incorporated in production models.
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